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Executive Summary 
The purpose of this document is to provide a guideline to the setup of Cisco server 
(Model: IBM Based 7845-I2) for application deployment in the Cisco IPCC environment.  
This guide will address the areas of setup based on best practices provided from Cisco 
Systems with any modifications required for equipment deployment in the FAA San 
Diego environment. 

 

With new hardware, even with the same part number, you may have revisions of the 
accompanying software that may affect this guide.  Please contact AT&T if this happens 
and this document will be updated to reflect these changes. 

 

It is also suggested to contact Cisco or log on to www.cisco.com and find the latest 
supported versions of the server setup software. 

 

This guide has been designed to be usable by both an experienced IT engineer or one 
with less experience in the area of server setup.  This document was designed to help the 
engineer through the many choices you have during setup to achieve a designated 
configuration for Cisco IPCC environment on a Windows Server 2003 operating system. 
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Requirements 
1. System Power  

a. The power supplying the system must be able to support the server’s 
requirements:  Rated line voltage 100-127 VAC and 200-240 VAC & Rated 
input current 10A (100 VAC), 10A (120 VAC), and 5A (200 VAC) 

b. UPS protection is strongly suggested for this server if it will be in 
production, along with Windows 2003 agents to respond to an outage with 
a graceful shutdown. 

2. HVAC & Operating environments 

a. The system should be set up in a cool, dry area for optimal operation.  
Range of 50° to 95° F (10° to 35° C) at 0 - 3000 feet (0 - 914.4 meters) 
with an altitude derating of 0.75° C per 1000 ft to 10,000 ft (3048 m) 

b. Cooling should be able to handle a BTU rating of BTU/hr 3390 

c. Maximum altitude 7000 ft (2133 m) 

3. Input and Output 

a. Keyboard, Video and Mouse or a KVM connection is required. 

b. Network Connection 

i. The Ethernet cable should be connected to an active network 
connection on a network switch. 

ii. Speed and Duplex MUST be set on both the server and switch to 
match (Not Auto).  This deployment has been tested at 100/full and 
testing is continuing with 1000/full.  At the time of this document, 
the gigabit/full has not been certified. 

iii. Prior to installing the server, you should collect what the IP address, 
Subnet Mask, Default Gateway, DNS Server, and WINS server will 
be. 

iv. All TCP/IP ports should be open and accessible to the client devices 
that they will be supporting; a more granular list is based on what 
application will be installed on the system. 

v. SNMP version, Community strings, and security levels. 

vi. Windows Active Directory access if joining a Windows Domain 

4. Hardware Manufacturers & Microsoft Media 

a. Server setup disk (Required for RAID setup) must have a minimum of 2 
hard drives for mirrored operation (RAID 1).  

b. Microsoft Windows Server 2003 R2 Enterprise Edition Disks 

c. Product Key for Windows 2003 
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Server Specifications 
This section has been based on the Cisco® MCS 7845-I2 (IBM) Media Convergence Server, which is a high-
availability server platform for Cisco Unified Communications solutions.  

 

• Two Intel 5140 Xeon 2.33-GHz processors, a 1333-MHz front side bus (FSB), and 4 MB of Level 2 
cache 

• 4-GB ultra-fast fully buffered 667-MHz PC2-5300 double-data-rate 2 (DDR2) Error Checking and 
Correcting (ECC) memory with Chipkill protection  (Must be installed in pairs) 

• IBM ServeRAID 8k Redundant Array of Independent Disks (RAID) Controller with 256-MB memory 
and battery-backed caching 

• Dual-port Gigabit Ethernet controller (embedded) 

• Quick-deployment third-party rail kit 

• Support for up to eight small form-factor hot-plug hard drives 

• Hot-plug redundant power supplies 

• Hot-plug redundant fans 

• IBM LightPath Diagnostics to assist in identifying failed components 

• IBM Slimline Remote Supervisor Adaptor II (RSA II) 

• The adapter continuously monitors system environmental elements (temperatures and voltages); 
operating system status; and critical system components such as processors, voltage regulator 
modules (VRMs), memory, fans, power supplies, and power backplanes (where supported by the 
system). 

• Video compression hardware is built in, eliminating drivers. 

• Faster graphics support makes monitoring and control more efficient. 

• RSA II SlimLine supports Secure Sockets Layer (SSL) and Lightweight Directory Access Protocol 
(LDAP). 

• The adapter is integrated with IBM Director and Director Agent. 

• Built-in LAN and serial connectivity supports virtually any network infrastructure. 

• Multiple alerting functions warn systems administrators of potential problems via e-mail, pager 
support, LAN, or Simple Network Management Protocol (SNMP). 

• The adapter installs on the system planar using a dedicated connector, eliminating the need to use 
a PCI-X slot. 

• The RSA II SlimLine features are similar to the RSA II with the exception of the following features: 

o The reset button is not accessible from the back of the system. 

o A mini-USB cable is no longer required; the device uses an internal USB bus. The system 
has a designated systems management Ethernet port, activated only when RSA II 
SlimLine is installed. 

o An external AC adapter is not required (the device uses standby power from system 
power supplies). 

o Status LEDs are not externally viewable. 

o The RSA II SlimLine no longer supports the prior RSA II interconnect function. 
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Application Support 
The Cisco MCS 7845-I2 can run any of the following Cisco applications: 

• Cisco Unified Communications Manager 

• Cisco Emergency Reporter-Up to 30,000 Cisco Unified IP phones per server 

• Cisco Unified Intelligent Contact Management Enterprise 

• Cisco Unified Contact Center Enterprise 

• Cisco Unified Customer Voice Portal 

• Cisco Unified MeetingPlace Express 

• Cisco Unity® Unified Messaging 
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Preparing for Server Setup 
1. You will need the following information during the install.  This should be collected 

prior to starting the installation. 

a. Drive Information 

i. RAID Type: RAID 1 only supported by Cisco (2 Drives Minimum)  

b. Customer Information 

i. Username 

ii. Computer Name 

iii. Organization 

iv. Password for Server 

v. Domain name that it will attach to 

vi. Login & Password for a Windows AD Domain account that can add 

systems domain is needed 

c. Software Information 

i. Software Media (Server setup and Windows 2003 R2) 

ii. Patches for Windows Server 2003 R2 (Current list at 

www.cisco.com) 

iii. Product ID (Windows 2003 Serial Number) 

d. Network Information 

i. IP address 

ii. Subnet Mask 

iii. Default Gateway 

iv. DNS Server 

v. WINS server 
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Server Setup & Partitioning Guide 
1. Using the ServerGuide CD that came with the system, go through the following screens. 

2.   

a. This should be the first screen you see after putting in the IBM Server Guide CD. 

3.   

a. Choose language “English.” 
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4.   

a. Under Keyboard & Country Choose United States. 

5.  

a. Accept License Agreement (please review agreement), then select <NEXT>. 
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6.  

a. Welcome information (please review), then select <NEXT>. 

7.  

a. Select Microsoft Windows Server 2003 R2 Enterprise Edition, then select <NEXT>. 
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8.  

a. Select <NEXT>. 

9.  

a. Set current local date & time (12-Hour Clock), then select <NEXT>. 
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10.  

a. Please review tasks, then select <NEXT>. 

11.   

a. Select the “Clear Drive Info” button then select <NEXT>. 
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12.  

a. The ServerRAID Manager software will now load.  (An automated Firmware upgrade will 

happen at this point if your RAID firmware is out of date.) 

13.   

a. Select Custom, then select <NEXT>. 
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14.  

a. Select RAID 1 button, then select <NEXT>. 

15.  

a. Select Drive 0 & 1 for the mirror, then select <NEXT>. 
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16.   

a. Select <Continue>. 

17.   

a. Build should be completed in less than a minute. 
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18.   

a. You will repeat the process for the second pair of Drives 2 and 3.  When you have finished 

Drives 2 and 3, you may exit the application.  (Click the X in the upper right corner of the 

screen, or select File  Exit. 

19.  

a. Review tasks, then select <NEXT>. 
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20.   

a. You can expect many reboots during this setup.  Leave the CD in the system if it was not 

ejected prior to this point. 

21.   

a. This is part of the OS setup.  Select the maximum amount of space and choose NTFS as the 

format type. 
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22.   

a. Review Status Screen (All should say Complete), then select <NEXT>. 

23.  

a. Review Status Screen, then select <NEXT>. 
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24.  

Enter the Following FAA San Diego information: 

a. Username 

b. Computer Name 

c. Organization 

d. Product ID (Windows 2003 Serial Number) 

e. Password to be used (Remember Password!) 
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25.   

a. You can use the default workgroup name and add the system to the domain later; otherwise 

you will need the Domain name that the system will attach to and a Login & Password for the 

Domain account that can add systems to the domain. 

26.  

a. Begin the setup of the network.  If you have all the information, then you can do a custom 

install.  If not, use the default install and add the information later. (We will continue as if 

selecting Default) 
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27.   

a. The licensing will be based on what product you are installing, then select <NEXT>. 

28.  

a. Select English and Western (Defaults), then select <NEXT>. 



 
AT&T Consulting Services 

 August 15, 2008 ▪ Version 1.0 Server Setup & Partitioning Guide • 22 

This document and the information it contains is for FAA San Diego’s use only and is not for resale and/or revenue generation purposes to third parties. 

29.  

a. Under Microsoft Components Selection you will choose the following beyond the defaults: 

i. Simple Network Management Protocol (SNMP) 

ii. WMI Windows Installer Provider  

Then select <NEXT>. 

30.  

a. This information contains instructions on how to access IBM drivers (should not be required 

during this installation), then select <NEXT>. 
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31.  

a. Stand by for File copy, then select <NEXT>. 

32.  

a. Remove the Server Setup CD and put in Disk 1 of the Windows 2003 R2 CD, then select 

<NEXT>. 
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33.  

a. The remaining processes are mostly automated and will require the system to reboot many 

times to create a system running Windows Server 2003 R2.  Place the Windows Server R2 CD 

in the system, then select <NEXT>. 

34.  

a. Automated – Please wait. 
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35.   

a. Automated – Please wait. 

36.  

a. Automated – Please wait. 
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37.  

a. Put in Windows Server 2003 R2 CD 2 and click OK. 

38.  

a. When the OS is fully active, you will be presented with the Windows Server Post-Install 

Security Update screen and asked to install the latest updates.  Exit this screen and reboot 

the server manually.  This step will prevent any errors in the next few screens. 
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39.  

a. After reboot, run Windows Update again and it will install SP2. Review the www.cisco.com site 

for current patches for the system. (All updates MUST be Cisco approved.) 

40.  

41. After the installation of SP2 and the other patches, exit Windows Update and reboot the system.  Now the 

system should be ready for the application installation.
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How to Join Standalone Servers to the Domain 

 
1. Step 1: Right-click My Computer and select Properties > Network Identification Tab > Properties. 
2. Step 2: Click Domain, then enter the Fully Qualified Domain Name. 
3. The following components must be installed on servers that are members of the domain: 

a. Logger 
b. CallRouter 
c. AWs 
d. WebView Server 

i. Note: WebView must be installed on the same domain as the AW/HDS. 
4. Step 3: Enter the Domain Administrator’s username and password. 
5. Step 4: Reboot the server and log in to the domain. 

 

How to Customize Your Desktop 
Customize your desktop on all ICM components. 

1. Step 1: Create shortcuts on desktop, as detailed in the ICM/IPCC System Design Specification. 
2. Step 2: Configure the command prompt: 

a. Open the command prompt from the desktop shortcut. 
b. Right-click in the title bar and select Defaults. 
c. On the Options tab, uncheck Insert Mode. 
d. Select the Font tab. Set the command prompt font size to 7x12. 
e. Select the Layout tab. Set the Command Prompt screen buffer to 200x9999. 

3. Step 3: Set the Folder Options 
a. Open the Control Panel then open Folder Options. 
b. On the General tab, select Use Windows classic folders. 
c. On the View tab, select Display the full path for the address bar and title bar. Select Show 

hidden files and folders and uncheck Hide extensions for known file types. 
 

Network Card Settings 
1. To set up the network card settings: 

a. Select Start > Control Panel > Network Connections then, in the menu bar, click Advanced > 
Advanced Settings. The Advanced Settings dialog box appears. 

b. Use the following guidelines to configure network card settings: 
i. Rename each Local Area Connection to private, visible, and san as required. 

1. In the Advanced tab to the connection properties, configure the network 
(link) speed and duplex mode. 

2. For example: Set card to 100 MB per second and Full duplex. 
a. Warning: Do not leave configuration set to Auto mode. 

c. In the Advanced tab, do the following: 
i. In the Connection section of the Adapters and bindings tab, sort the section so that 

the visible connection is at the top, the Private connection is second, and any 
remaining connections follow. 

1. For the Private connection, uncheck File and Printer Sharing for 
Microsoft Networks and Client for Microsoft Networks. 

2. Move any disabled Bindings for all connections to the bottom of the list. 
d. Persistent Static Routes 

i. For geographically distributed ICM software central controller sites, duplexed Call 
Router and Logger components have a Private IP WAN connection, used to 
communicate between Side A and Side B. Because Windows only allows one default 
gateway for each server (which sends the Private Network traffic to the Visible 
Network), you must add a set of Static Routes to all the servers running the Call 
Router and Logger. 

ii. On the Side A Call Router and Logger servers, enter route add 
<networknumber>mask<subnet mask><gateway IP> -p. 
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iii. For example: 
1. On Side A servers, enter route add 192.168.142.42 mask 255.255.255.192 

192.168.141.126 -p. 
2. On Side B servers, enter route add 192.168.141.64 mask 255.255.255.192 

192.168.142.126 -p. 
3. The network number of the remote Private Network is 192.168.142.42 
4. The subnet mask for this remote network is 255.255.255.192 
5. The gateway address for the Private Network Adaptor is 192.168.141.126 
6. Note: The -p option sets the route as persistent. 

SNMP Management 
SNMP management support is installed and enabled by default on ICM/IPCC Enterprise and Hosted Edition 
servers. However, to ensure seamless integration with the Microsoft native SNMP components, installation of 
the Microsoft Management and Monitoring Tools subcomponents is required. 

1. To install these required subcomponents, from the Control Panel: 
a. Select Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows 

Components 
b. Select Management and Monitoring Tools. 

i. Click Details. 
ii. Select Simple Network Management Protocol and WMI Windows Installer Provider. 
iii. Click OK then click Next to continue with the wizard to install these subcomponents. 

1. Note: You may need to have your Microsoft Windows 2003 Server CD handy 
to complete the installation. 

iv. When the installation is complete, click Finish. 
2. If SNMP management support has already been installed and configured for this server, the existing 

configuration parameters should be collected so they can be used to configure the components 
installed by ICM SETUP. These parameters can be found on the property sheets associated with the 
Microsoft SNMP Service. 

a. To collect existing SNMP properties: 
i. On the Services MMC console, locate and select the SNMP Service in the list. 
ii. Select Start > Programs > Control Panel > Services. 
iii. Click Properties (or select the Properties context menu). 
iv. On the SNMP Service Properties dialog, select the Security tab. 

1. Note the following settings and configuration data: 
a. The state of the Send authentication trap checkbox. 
b. The Accepted community names. 
c. If Accept SNMP packets from these hosts is checked, collect the 

host names and/or IP addresses configured in the associated list 
box. 

2. Note: If host names (vs. IP addresses) have been configured, you need to 
determine the actual IP address of that host to configure the Cisco SNMP 
agents. For security reasons, using static addresses for management 
stations is preferred. 

v. Select the Traps tab on the SNMP Service Properties dialog box. 
vi. Collect the configured trap destinations and the associated community name. 

1. Note: If host names were for trap destinations, you need to determine the 
actual IP address of that host. 

vii. On the SNMP Service Properties dialog, select the Agent tab. 
viii. Collect the information from the Contact and the Location fields. 
ix. If the server has not been configured for SNMP manageability, engage in a dialog 

with the customer IT professionals to: 
1. Determine whether the customer desires SNMP manageability. 
2. Acquire the necessary configuration information to enable SNMP access. 
3. The necessary configuration information includes: 

a. The IP addresses of the management station(s). 
i. If using SNMP v1 or SNMP v2c: 
ii. Community names (if using SNMP v1 or SNMP v2c) 
iii. Trap destinations and the community name expected by 

each management station 
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iv. If using SNMP v3: 
1. User names 
2. Authentication protocol used (if authentication is 

required) 
3. Privacy protocol used (if privacy is required) 
4. Trap destinations and the user name expected by 

each management station 
5. The installed Microsoft Management Console 

Snap-In (Cisco SNMP Agent Management) is used 
to configure the SNMP properties. Please consult 
the ICM/IPCC SNMP User Guide for details. 

Installing the Windows Firewall 
1. Load the appropriate Service Pack. Do not manually configure the firewall; use theCiscoICMfwConfig 

application, which installs and configures the Windows firewall. 
a. For additional information, refer to the Security Best Practices Guide for Cisco ICM/IPCC 

Enterprise & Hosted Editions, Release7.0(0) 
(http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/coreicm7/config7
/index.htm) 

b. For detailed information on supported platforms for ICM software, see the Cisco 
ICM/IPCCEnterprise & Hosted Editions Release 7.0(0) Hardware and System Software 
Specifications(Bill of Materials) 
(http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html) 

c. For additional information on the Windows Firewall see the: 
d. Windows Server 2003 Windows Firewall (WF) 

(http://www.microsoft.com/technet/prodtechnol/windowsserver2003/technologies/wf.mspx)H
elp: Windows Firewall How 
To...(http://www.microsoft.com/technet/prodtechnol/windowsserver2003/library/ServerHelp/
005d7651-fefa-4e00-8f55-714fc0175fe1.mspx) 

Remote Monitoring System Requirements 
1. Follow the instructions below if you plan to use the Phone Home capabilities of Cisco Remote 

Monitoring System (RMS) software. The RMS software sends events to the Cisco Technical Assistance 
Center. 

a. Note: Enable the Phone Home system on servers running the Logger component 
2. Drive Shares 

a. You must configure a hidden share folder on the C drive of servers running the Logger 
component in order for RMS Listeners to access Phone Home events. 

Routing and Remote Access Configuration 
1. If the Logger is utilizing Phone Home functionality using a modem, you must configure a Listener 

server for Routing and Remote Access. This provides dial-up access to the Listener for the Remote 
Monitoring System (page 94) and Phone Home functionality. 

2. Typically a deployment also has one Peripheral Gateway that the Cisco Technical Assistance Center can 
access. 

a. Note: When monitoring pre-ICM 5.0(0) systems, you must use Windows 2000 as your 
operating system due to the NET BEUI requirements for RMS. 

3. When Monitoring ICM 5.0(0) and ICM 6.0(0) systems using NET BEUI, you must have Windows 2000 
as your operating system until you reconfigure the Logger to use TCP/IP. At this point, you can 
upgrade to Windows 2003. 

a. Refer to the Remote Monitoring Suite Administration Guide for Cisco ICM/IPCC Enterprise& 
Hosted Editions, Cisco Remote Monitoring Suite Release 2.1(0) for information concerning 
how to configure routing and remote access using the Routing and Remote Access Server 
Setup Wizard. 
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Automatic Updates 
1. Refer to the Security Best Practices Guide for Cisco ICM/IPCC Enterprise & Hosted Editions, Release 

7.0(0) 
(http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/coreicm7/config7/index.ht
m) for information on this setting. 

2. Display Settings 
a. Through the Windows Control Panel Display dialog box: 

i. Ensure that no Screen Saver is selected. 
ii. Set the AW display for at least 1024 by 768 pixel resolution. 
iii. Set at least 65K colors and at least 60 MHz. 

b. System Properties 
i. Through the Windows Control System dialog box Advanced tab: 
ii. When setting virtual memory, set the initial and maximum total paging file sizes to 

the values recommended by the system. 
iii. For Startup and Recovery settings, set the value of the Time to display list of 

operating systems to 3 seconds. 
iv. On the Advanced tab of the System Properties dialog box, set the Performance 

Options to either Programs or Background Services. 

Event Viewer Configuration 
1. Configure the Event Viewer: 

a. For each type of event, set the Maximum log size to 8192 KB. 
b. Select Overwrite events as needed. 

1. Note: These settings are configured by the Security Template provided with 
automated hardening on Windows Server 2003. Refer to the Security Best 
Practices Guide for Cisco ICM/IPCCEnterprise & Hosted Editions, Release 7.0(0) 
(http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/coreic
m7/config7/index.htm) for additional information. 

Remote Control Options 
2. Refer to the following documents for information on remote control options: 

a. Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0) Hardware and System Software 
Specifications (Bill of Materials) 
(http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html) 

b. Security Best Practices Guide for Cisco ICM/IPCC Enterprise & Hosted Editions, Release 7.0(0) 
(http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/coreicm7/config7
/index.htm) 

Connectivity Validation 
1. Before you begin the ICM software installation process, you should validate network connectivity for all 

servers that are part of the ICM software system. 
2. On each server: 

a. Validate the TCP/IP properties for each network card, including the DNS settings. 
b. Validate that you can ping each machine on the visible network. 
c. If applicable, validate that you can ping each private network connection. 

 

Test remote access. 
1. Note: Refer to the System Design Specification to confirm that the system topology is correct. 

 


